
 

LESSON SKILL MATRIX 
 

Skill Exam Objective Objective Number 
 

Creating a Chart Using the Chart Wizard Add report controls 5.2.5  

Formatting a Chart Modify data sources 5.2.4 

Changing Chart Types 

Saving a Database Object as Another File Type 

Printing a Database Object 

 
 
 

 
 
 
 

 

 
•  chart 

•  chart body 

•  Chart Wizard 

•  client object 

•  legend 

•  PDF 

•  XPS 
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Blue Yonder Airlines is a small but rapidly growing regional airline. In your 

position as Investor Relations Specialist, you assist in building investor re- 

lations programs, creating and distributing analyst reports, maintai n i ng 

and updating databases, and preparing materials for conference prese n ta- 

tions. In this lesson, you will create, save, and print charts that will be repro- 

duced and included in a report detailing the growth of Blue Yonder Airlines. 

You will also save a table as a report to help communicate data in a more 

effective way. 

 
 

CREATING A CHART USING THE CHART WIZARD 

Charts are often used in the business world to give a visual representation of numeric data. Because 
a picture is worth a thousand words, charts play an important role in reports and presentations. In 
Access 2013, you can insert a chart into a new or existing form or report using the Chart control. 

 

Creating a Chart Using the Chart Wizard 

The Chart control lets you insert a chart into a new or existing report or form using a table or 
query as your data source. This allows you to insert a pictorial view of the data along with the 
numbers. Once a chart has been inserted, the Chart Wizard asks you questions about the chart 
you want and then creates the chart based on your answers. In this exercise, you will insert a chart 
into the Page Footer section of a report because it is a one-page report and it is helpful to show the 
data at the bottom of the page after the columnar data. 

 

Take Note Charts and graphs are terms used synonymously in Microsoft Access. For example, the Chart 
control inserts a chart into reports or forms; however, a chart is referred to as a graph in Visual 
Basic for Applications (VBA) code. 

A chart is a graphical representation of data. Although charts can contain various components 
used to help make data more meaningful, most are made up of two basic parts, the body and the 
legend. The chart body is the main area that displays the chart. The legend displays a list of the 
colors, shapes, or patterns used as categories in a chart. 

 

Once a chart has been inserted into a report or form using the Chart control, the Chart Wizard 
asks you questions to quickly create a customized chart. Once you insert a chart, you may need to 
resize it later; you can do so by clicking and dragging the selection handles to increase or decrease 
the height or width. 

 

You could also place the chart in the Detail section of the report and set the chart to change with 
each record by enabling this option within the Chart Wizard. You would then have a report dis- 
playing the record data and a chart for each record. 

 

You can create 20 different charts using the Chart Wizard, including column, bar, area, line, XY 
scatter, pie, bubble, and doughnut charts. 

 

To delete a chart, right-click it in Design view and select Delete from the shortcut menu. 
 
 

 
 

GET READY. Before you begin these steps, be sure to turn on and/or log on to your 

computer and LAUNCH Access. 

1.  OPEN Blue Yonder Airlines from the data files for this lesson. 

STEP BY STEP Create a Chart 

The Bottom Line 
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2.  SAVE the database as Blue Yonder AirlinesXXX (where XXX is your initials). 

3.  Open the Income & Expenses report. 

4.  Switch to Design view. 

5.  On the REPORT DESIGN TOOLS DESIGN tab, in the Controls group, click the Chart 
button. The pointer changes to a plus sign with a chart icon. 

6.  Click in the upper-left corner of the Page Footer section and drag to the lower-right 
corner to create a rectangular placeholder where the chart will be inserted, as shown in 

Figure 13-1. 

 
Figure 13-1 

 

 

Report in Design view 

Chart button 

 

 

 

 

 

 

 

 

 

 

 

 
Rectangle for chart 

 

 

 

 

 

 

 

 

 

 
 

7.  Release the mouse button. The first Chart Wizard dialog box appears, as shown in 

Figure 13-2. 

 
Figure 13-2 

 

 

First Chart Wizard dialog box 
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8.  Select the Income & Expenses Summary table as your data source and click the Next . 

button. The second Chart Wizard dialog box appears, as shown in Figure 13-3. 

 
 

Figure 13-3 
 

 

Second Chart Wizard 

dialog box 

 
 

 
 
 

9.  Click the More (..) button to move all the fields to the Fields for Chart box and click  

the Next . button. The third Chart Wizard dialog box appears, as shown in Figure 13-4. 

 
Figure 13-4 

 

 

Third Chart Wizard dialog box 

3D Column Chart button 

 
 
 
 

 
 
 
 

Chart description 

 
 
 

 
 
 
 

 
 

10.  Click the 3D Column Chart button, the second icon in the first row. Notice that the 

description of the chart type is displayed on the right. 

11.  Click the Next . button. The fourth Chart Wizard dialog box appears, as shown in 

Figure 13-5. 
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Figure 13-5 
 

 

Fourth Chart Wizard 
dialog box 

Preview Chart button 

 
 
 

 
 

 
Field buttons 

 
 

 
 
 
 

 
 
 
 

12.  Click and drag the Income field button to the upper left of the chart and drop on the 
SumofExpenses data list. Both the SumofExpenses and SumofIncome fields should  

be listed. 

13.  Click the Preview Chart button. The Sample Preview dialog box appears, displaying a 

sample of your chart, as shown in Figure 13-6. 

 
 

Figure 13-6 
 

 

Sample Preview dialog box 

 
 

 
 
 

14.  Click the Close button. The Sample Preview dialog box closes. 

15.  Click the Next . button. The fifth Chart Wizard dialog box appears, as shown in 

Figure 13-7. 
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Figure 13-7 
 

 

Fifth Chart Wizard dialog box 

 

 
 
 

16.  Click the down arrow in the Report Fields menu and select ,No Field. since you don’t 

want to display a chart for each record in the data source. 

17.  Click the down arrow in the Chart Fields: menu and select ,No Field. again, since you 

don’t want to display a chart for each record in the data source. 

18.  Click the Next . button. The sixth Chart Wizard dialog box appears, as shown in 

Figure 13-8. 

 
 

Figure 13-8 
 

 

Sixth Chart Wizard dialog box 

 
 

 
 

 
19.  Key 2008-2017 Income and Expenses in the Title box. 

20.  The Yes, display a legend button should be selected. If not, select it and click the Finish 

button. Access inserts your chart. Notice that Design view displays sample data and 

not the actual data from your chart. 

21.  Click the chart to select it. 

22.  On the REPORT DESIGN TOOLS DESIGN tab, in the Tools group, click the Property 

Sheet button, if necessary. 

23.  Click the DATA tab of the Property Sheet. Click the down arrow at the end of the 

Enabled cell and select Yes. This enables the chart to accurately display the 

associated table data. 
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Figure 13-9 
 

 

Report with 3D bar chart 

24.  CLOSE the Property Sheet. 

25.  Sw itch to Report view. 

26.  On the HOME tab, in the Records group, click the Refresh All button to ensure the chart 

displays the latest table data. 

27.  Scroll to the bottom of the report to view  your chart, which should look similar to 

Figure 13-9. 

 

 

Chart body Legend 

 
 
 

Troubleshooting If your chart is not displaying correctly, you probably need to increase or decrease the width 

and/or height of the placeholder. You do this the same way you resize any control. Switch to 

Design view and click the resize handles in the center of the vertical borders and drag to 
increase or decrease the size. Drag the resize handles on the horizontal borders to change the 

height. Then, return to Report view to see the results. 

 
28.  SAVE the report. 

 

PAUSE. LEAVE the report open to use in the next exercise. 
 

 

 

 

FORMATTING A CHART 

You can use Microsoft Graph to change the formatting of charts created with the Chart Wizard. 
You can change chart options such as how the title and labels are displayed and where you want 
the legend located. You can also change formatting options, such as the color of the chart’s back- 
ground and the color and size of the data blocks in the chart. 

 
After you create a chart using the Chart Wizard, you can edit it using Microsoft Graph, which is 
a component of Office 2013. To launch Microsoft Graph, double-click a chart in Design view. 
Microsoft Graph displays the chart and datasheet. You can choose commands from the menu bar 
or the toolbar. 

 

How do you add report 

controls? 

The Bottom Line 
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After you make changes to the chart, it is important to save the changes using the Save com- 
mand on the File menu. After you save a chart, Microsoft Graph closes and switches you back to 
Design view. 

 

Changing Chart Options 

The Chart Options dialog box has six tabs with options for changing the look and layout of a 
chart. You can access the Chart Options dialog box from the Chart menu or by right-clicking the 
white Chart Area and selecting Chart Options from the shortcut menu. In this exercise, you will 
change chart options using Microsoft Graph. 

 

 
 

 
 

 
 

 
 

 

Figure 13-10 
 

 

Chart displa yed in 
Microsoft Graph 

USE the report that is open from the previous exercise. 

1. Sw itch to Design view. 

2. Double-click the chart. The Microsoft Graph software launches, displaying the chart in 

a view  similar to Design view , as shown in Figure 13-10. 

 

Chart Objects menu 
 

Menu bar Walls Chart title Toolbar 

 

 
Datasheet Data series Chart area 

STEP BY STEP Change Chart Options 
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3. Click Chart  on the menu bar and select Chart  Options from the menu that appears. The 

Chart Options dialog box appears, as shown in Figure 13-11. 

 

 

Figure 13-11 
 

 

Titles tab on the Chart Options 

dialog box 

 
 

 
 
 

4. Click the Axes tab to display the options on the tab, as shown in Figure 13-12. 

 

 

Figure 13-12 
 

 

Axes tab of the Chart Options 
dialog box 

 
 

 
 

 
5. Click the Value (Z) axis check box to remove the check mark. Notice that the values on 

the Z axis are removed. 

6. Click the Value (Z) axis check box again to insert the check mark. 

7. Click the Gridlines tab to display the options on the tab, as shown in Figure 13-13. 
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Figure 13-13 
 

 

Gridlines tab of the Chart 
Options dialog box 

 

 
 

 
8. Click the Major gridlines check box in the Category (X) axis section. Notice that 

gridlines are added to the preview. 

9. Click the Legend tab to display the options on the tab, as shown in Figure 13-14. 

 

 

Figure 13-14 
 

 

Legend tab of the Chart 
Options dialog box 

 
 

 
 

 
10. Click the Show legend check box to remove the check mark. Notice that the legend is 

removed from the chart. 

11. Click the Show legend check box again to insert the check mark. The legend is 

displayed in the preview . 

12. Click the Bottom option button to move the legend to the bottom of the chart. 

13. Click the Dat a Labels tab to display the options on the tab, as shown in Figure 13-15. 
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Figure 13-15 
 

 

Data  Labels tab of the Chart 
Options dialog box 

 

 
 

 
14. Click the Value check box to insert a check mark. Notice that values are added to the 

columns in the chart. 

15. Click the Value check box again to remove the check mark. 

16. Click the Dat a Table tab to display the options on the tab, as shown in Figure 13-16. 

 

 

Figure 13-16 
 

 

Data  Table tab of the Chart 

Options dialog box 

 
 

 
 
 

17. Click the Show data table check box to insert a check mark. Notice that the datasheet is 

added to the bottom of the chart. 

18. Click the Show data table check box again to remove the check mark. 

19. Click OK. 

20. Click the File menu and select Save. The Microsoft Graph software closes and the 

report is sw itched back to Design view . 

 

PAUSE. LEAVE the report open to use in the next exercise. 
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Changing Format Options 

Microsoft Graph makes it easy to format a chart. Each part of the chart is an independent object, 
so you can simply right-click the chart object that you want to change and choose Format [Chart 
Object] from the shortcut menu. A dialog box appears with the formatting choices available for 
that object. In this exercise, you will format the chart you have been creating. 

 
If you prefer to use the menus, you can click on the chart object to select it or choose it from 
the Chart Objects list box on the toolbar. Once you have specified the object you want to 
change, click the Format menu and choose Selected [Chart Object] from the menu to launch 
the dialog box of available options. 

 

 
 

 
 

USE the database that is open from the previous exercise. 

1. Double-click the chart to open Microsoft Graph. 

2. Click the Chart Area, the white background of the chart, to select it. The Chart Area 

should be displayed in the Chart Objects list box in the upper-left corner of the toolbar. 

3. Click the Format menu and select Selected Chart Area. The Format Chart Area dialog 

box appears, as shown in Figure 13-17. 

 

 

Figure 13-17 
 

 

Forma t Chart Area dialog box 

 
 

 
 

 
4. Click the Fill Effects button. The Fill Effects dialog box appears, as shown in 

Figure 13-18. 

 

Microsoft Graph has its own Help system. To access it, double-click a chart to launch Microsoft

Graph and choose Microsoft Graph Help from the Help menu or press F1. 

STEP BY STEP Change Format Options 
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Figure 13-18 
 

 

Fill Effects dialog box 

 

 
 

 
5. Click the Horizontal option button in the Shading styles section and click OK. 

6. Click OK in the Format Chart Area dialog box. Notice the shading style of the chart 

background changes to your selection. 

7. Right-click any of the purple Data Series columns in the chart to display the shortcut 

menu. Notice that Series “SumOfIncome” is displayed in the Chart Objects list box. 

8. Select Format Data Series from the shortcut menu. The Format Data Series dialog box 

appears. 

9. Select the Green color (second row , fourth from the left) as shown in Figure 13-19. 

 

Figure 13-19 
 

 

Forma t Data Series dialog box 

 

 
 
 

 
Green color selected 
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10. Click OK in the Format Data Series dialog box. 

11. Right-click the gray grid background of the chart, called the Walls, and select Format 
Walls from the shortcut menu. 

12. Click the Fill Effects button. 

13. Click the From center button in the Shading styles section and click OK. 

14. Click OK in the Format Walls dialog box. 

15. Right-click the Legend and select Format Legend from the shortcut menu. The Format 
Legend dialog box appears. Select the Font tab if it is not already displayed. The Font 

tab menu now appears, as shown in Figure 13-20. 

 
 

Figure 13-20 
 

 

Font tab of the Forma t Legend 
dialog box 

 
 

 
 
 

16. Select 12 in the Size: menu and click OK. Notice the font size of the legend text 

has increased. 

17. Click the File menu and select Save. Switch to Report view to view your changes. 

18. SAVE the report. 
 

PAUSE. LEAVE the report open to use in the next exercise. 
 

 

 

Refreshing Data in a Chart 
The Refresh All button can be a useful tool when working with charts. When you make a change 
to the data source of a chart, be sure to save the new data in the table or query. When you switch 
back to the form or report containing your chart, click Refresh All to update the data in the chart 
with the modified data. In this exercise, you will make a change to a table record and then refresh 
the data in a chart to view the change. 

 

 
 

 
 

USE the database that is open from the previous exercise. 

1. OPEN the Income & Expenses Summary table. 

STEP BY STEP Refresh Data in a Chart 
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2. In the first row , in the Income column, select the data and key 9004523 and 

[press Enter]. 

3. SAVE and CLOSE the table. 

4. Click the Income & Expenses report tab. Notice that the numbers in the report data and 

the numbers in the chart have not changed. 

5. On the HOME tab, in the Records group, click the Refresh All button. The data in the 

report and in the chart are updated. 

6. SAVE the report. 

 

PAUSE. LEAVE the report open to use in the next exercise. 
 

 

 

 

CHANGING CHART TYPES 

Access provides many different chart types and variations of those chart types for you to choose 
from in the Chart Type dialog box. Access makes it easy to experiment with different configura- 
tions before you decide on the chart that best displays the data you want to emphasize. In this 
exercise, you will change the type of chart with which you have been working. 

 

Changing Chart Types 

Access 2013 has many different types of charts you can choose from. The key is to choose one that 
displays your data in a meaningful way. Often, you have a specific chart in mind that you want to 
use, but sometimes it requires experimentation, choosing and changing chart types until you get 
the results you want. 

 

 
 

 
 

USE the database that is open from the previous exercise. 

1.  Sw itch to Design view. 

2.  Double-click the chart. Microsoft Graph opens. 

3.  Click the By Row button on the toolbar, as shown in Figure 13-21. The chart is changed 

to show all the expenses together and all the income together. 

 

Figure 13-21 
 

 

Microsoft Graph toolbar 

By Column button 

 
 
 

 
By Row button Chart Type button 

 
 

4.  Click the By Column button on the toolbar to change it back to the original chart. 

5.  Click the Chart  Type drop-down arrow  in the toolbar and select 3D Area Chart from the 

menu, as shown in Figure 13-22. The chart changes to an area chart. 

STEP BY STEP Change Chart Types 

 

How do you modify report 
data sources? 

The Bottom Line 
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Figure 13-22 
 

 

Chart Type button and menu 

 
 

 
 
 

 
 
 
 

 
 

6.  Click the Chart menu and select Chart Type. The Chart Type dialog box appears, as 

shown in Figure 13-23. 

 
Figure 13-23 

 

 

Chart Type dialog box 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 

 

7.  On the Standard Types tab, click Pie in the Chart type list. In the Chart sub-type section, 
click Pie with a 3D visual effect, the second icon on the first row. 

8.  Click and hold the Press and Hold to View Sample button to see a preview of the chart, 

as shown in Figure 13-24. 
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Figure 13-24 
 

 

Sample pie chart 
 

 
 

 
 
 

 
 
 
 
 
 
 

 
 

 
 
 

 
 

 
 
 
 

 
Figure 13-25 

 

 

Chart in Report Design view 

 

 
 
 
 

9.  Click the Custom Types tab. 

10.  Click Colored Lines in the Chart type: list and click OK. 

11.  Click the File menu and select Save. Your screen should resemble Figure 13-25. 

 

 
 

 

12.  Switch to Report view to view your changes. 

13.  SAVE and CLOSE the report. 
 

PAUSE. LEAVE the database open to use in the next exercise. 
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SAVING A DATABASE OBJECT AS ANOTHER FILE TYPE 

Microsoft Access 2013 allows you to save database objects, such as tables, forms, and queries, as 
other types of objects. For example, you can save a table as a report. Although you can save tables, 
forms, and queries as at least one other type of database object, Access doesn’t permit you to save 
reports as other object types; however, you can save all database objects as PDF or XPS files. Sav- 
ing a database object as another file type allows you to share data with other users or repurpose 
the data in other ways. Since you can create Access objects to be used on the web, you can also 
save all web-based database objects as the same object of a different type called a client object. For 
example, you can save a web-based table object as a client table object type, but you cannot di- 
rectly save the web-based table object as a form object until after it’s saved as a client table object. 
A client object is an object that can be accessed and modified in the Access application installed 
on your computer. 

 
The Save Object As command gives you the option of saving database objects such as tables, 
forms, and queries as other types of objects. You can also use the Save Object As command to save 
a database object in Portable Document Format (PDF) or XML Paper Specification (XPS) file 
formats. You might already be familiar with PDF files from documents you view on the Internet 
or share via emails. The PDF file format maintains the exact layout of the original file and can 
easily be shared. A new alternative to PDF, the XPS file format preserves document formatting; 
can be easily shared, printed, and archived; and is more secure. The Save Object As command also 
gives you the option of saving a database object as a client object. Saving an object as a client ob- 
ject is used when you want to save a web-based Access object as one that can be accessed and 
modified in the Access application installed on your computer. 

 

Using the Save Object As Command 
You can save objects such as tables, reports, and queries as other types of objects or files using the 
Save Object As command on the Save As menu. You can access the Save As menu by selecting the 
Save As command on the FILE tab. In this exercise, you save a table object as a new report object. 

 

 
 

 
 

USE the database that is open from the previous exercise. 

1. OPEN the Income & Expenses Summary table. 

2. Click the FILE tab, and then click the Save As tab to display the Save As menu. Click the 

Save Object As command in the File Types category, as shown in Figure 13-26. 

STEP BY STEP Save a Database Object as Another File Type 

The Bottom Line 
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Figure 13-26 
 

 

Save Object As command 

Save Object As command 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Save As button 

 
 
 

Save As types 

 
 

3. Notice the Save Object As option is already highlighted in the Save the current  

database object category. Click the Save As button. The Save As dialog box appears, as 

shown in Figure 13-27. 

 

 

Figure 13-27 
 

 

Save As dialog box 

 
 

 
 

 
4. Key Summary Report in the Save box. 

5. Click the down arrow on the As menu and select Report. 

6. Click OK. The table object is saved as a report object and the new Summary Report 

appears in Layout view . 

 

PAUSE. LEAVE the report open to use in the next exercise. 
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PRINTING A DATABASE OBJECT 

You are probably already familiar with printing various kinds of documents from your computer. 
Printing a database object uses the same print options and settings you use with other types 
of documents. 

 
You can choose various printing options before sending your document to the printer, such as the 
number of copies, size of the paper, or the range of pages to print. In this exercise, you will learn 
about some of the options available in the Print dialog box when you print a database object. 

 

 

 

 

 

 

 
 

Take Note 

You can print reports just by right-clicking the object in the Navigation Pane and selecting Print 
from the shortcut menu. An alternate way to print reports, and to print other objects like tables, 
queries, forms or macros, is to use the Print tab on the FILE tab. The Print tab displays available 
print options you can modify before you print an object. To print charts, you must open either the 
form or report that contains the chart or the table that is its record source. Changes that you make 
in the Print dialog box will only be applied to that particular document. 

 
When printing lengthy reports, you can choose other options, such as printing a range of pages, 
collating the pages, or printing multiple pages per sheet. 

 

 

 
 

USE the report that is open from the previous exercise. 

1. Click the FILE tab and select the Print tab on the menu. The Print tab displays available 

options, as shown in Figure 13-28. 

 

Figure 13-28 
 

 

Print tab available options 

STEP BY STEP Print a Database Object 

The Bottom Line 
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2. Click the Print button. The Print dialog box appears, as shown in Figure 13-29. 

 

 

Figure 13-29 
 

 

Print dialog box 

 
 

 
 
 

3. Click the Properties button. The Properties dialog box appears, as shown in Figure 13-30. 

Depending on your type of printer, the Properties dialog box could be different. You can 

change the quality, paper, printing, and orientation options available for your printer.  

Click the Cancel button. 

 

Figure 13-30 
 

 

Properties dialog box 



Display and Share Data 410 

 

 

4. Click the Setup button. The Page Setup dialog box appears, as shown in Figure 13-31. 

Click the Cancel button. 
 
 

Figure 13-31 
 

 

Page Setup dialog box 

 
 
 
 

 
 
 

 
 

 

 
Another Way 

You can also press 

Ctrl1P to display the Print 
dialog box. 

 

 
 

Another Way 

To print a document 
quickly, you can skip the Print 
dialog box and use the default 
print settings by clicking the 

Quick Print button, if added, on 
the Quick Access Toolbar. 

 
 

 
 
 

5. In the Copies section of the Print dialog box, click the up arrow in the Number of Copies 

menu to change the number of copies to 2. 

6. Click OK to print two copies of the report, or click Cancel (if you choose not to Print). 

7. CLOSE the report and table. 
 

CLOSE the database. 
 

 

 
 

SKILL SUMMARY 
 

In This Lesson You Learned How To: Exam Objective Objective Number 

Create a Chart Using the Chart Wizard Add report controls 5.2.5 

Format a Chart Modify data sources 5.2.4 

Change Chart Types 

Save a Database Object as Another File Type 

Print a Database Object 

 

 

 
 
 

Matching 

Match the term in Column 1 to its description in Column 2. 

Column 1 Column 2 

1. chart a. asks you questions to quickly create a customized chart. 

2. chart body b. contains 6 tabs with options for changing the look and 

layout of a chart 

Knowledge Assessment 
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3. Chart Wizard c. a file format that maintains the exact layout of the 
original file and can easily be shared 

4. legend d. a file format that preserves document formatting, 

can be easily shared, printed, and archived, and is 
more secure 

5. PDF e. a component of Access 2013 used to make 

changes to a chart created by the Chart Wizard 

6. Chart Options dialog box f. a graphical representation of data 

7. XPS g. allows you to save objects as other file formats 

like PDF and XPS 

8. Refresh All button h. the main area that displays the chart 

9. Microsoft Graph i. displays a list of the colors, shapes, or patterns 

used as categories in a chart 

10. Save Object As command j. updates the data in a chart 
 

True/False 

Circle T if the statement is true or F if the statement is false. 

T  F 1.   You can choose from 20 different chart types in the Chart Wizard. 

T  F 2.  The Chart Wizard is a control. 

T F 3.  A legend can be displayed only on the right side of a chart. 

T  F 4.   Microsoft Graph displays the chart and the datasheet of the underlying 

data source. 

T  F 5.   The Chart control can be used to insert charts in queries, forms, and reports. 

T F 6.  The Refresh All button updates data in a chart with data modified in the 

underlying data source. 

T  F 7.  You can save a table as a report. 

T F 8.  You can print reports by right-clicking the object in the Navigation Pane and 

selecting Print from the shortcut menu. 

T  F 9.   An Axis is a type of chart. 

T  F  10.   After you save a chart in Microsoft Graph, Microsoft Graph closes. 

 

 

 
 

Project 13-1: City Power & Light Salary Pie Chart 

The City Power & Light human resources department is reviewing the salary budgets for the office. 
Your supervisor asks you to create a pie chart within a report to show the distribution of funds for 
each employee. 

 
GET READY. LAUNCH Access if it is not already running. 

1.  OPEN the City Power & Light database. 

2.  SAVE the database as City Power & LightXXX (where XXX is your initials). 

3.  OPEN the Salary report in Design view. 

4.  Click the Chart button and draw a large rectangle in the space provided in the Page 
Footer section. The Chart Wizard dialog box appears. 

5.  Click the Next . button. 

6.  Move the Employee ID and Salary fields to the Fields for Chart: list and click Next .. 

7.  Click the Pie chart button and click Next .. 

8.  Drag and drop the Salary field button just below the SumofEmployee ID box Data box. 

9.  Drag and drop the Employee ID field button to the Series box. 

Competency  Assessment 
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10.  Click the Preview Chart button. 

11.  Click Close. 

12.  Click Finish. 

13.  Click the DATA tab of the Property Sheet and set the Enabled property to Yes. 

14.  Sw itch to Report view. 

15.  Click the Refresh All button. 

16.  SAVE the Report. 

17.  Click the FILE tab and select the Print  tab from the menu. 

18.  Click the Print  button and then click Cancel. 

19.  CLOSE the report. 

 

LEAVE the database open for the next project. 
 

 

 

 

Project 13-2: Change the City Power & Light Chart Type 

You decide to create a variation of the pie chart that will more clearly show the salary amounts in 
relationship to each other. 

 
USE the database that is open from the previous exercise. 

1.  OPEN the Salary report in Report view . 

2.  Click the FILE tab, and select Save As. 

3.  Click the Save Object As button. 

4.  Click the Save As button. 

5.  Key Salary Line Chart  in the “Save ’Salary’ to” box and click OK. 

6.  Sw itch to Design view. 

7.  Double-click the chart to launch Microsoft Graph. 

8.  Click the Chart  menu and select Chart Type from the menu. 

9.  Click Line in the Standard types list. 

10.  In the Chart subtype list, if not already selected, click the Line with markers displayed 

at  each data value button. 

11.  Click OK. 

12.  Click the Chart  menu and select Chart Options from the menu. 

13.  Click the Legend tab and click the Bottom option button. 

14.  Click OK. 

15.  SAVE the chart. 

 

CLOSE the database. 
 

 

 

 

 

 

 

Project 13-3: Create and Format an Expenses Chart 

You created a chart representing the Income & Expenses Summary table for Blue Yonder Airlines 
earlier. Now you need to create a chart solely for the expenses. 

 
GET READY. LAUNCH Access if it is not already running. 

1.  OPEN BlueYonderAirlinesXXX that you saved in an earlier exercise. 

2.  Create a chart using the Expenses Detail table as the data source. 

3.  Move the Amount and Yr fields to the Fields for Chart list and click Next .. 

Proficiency Assessment 
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4.  Click the Doughnut chart type button and click Next .. 

5.  Drag and drop the Yr field button to the Axis box and click Next .. 

6.  Select ,No Field. in the Report Fields and Chart Fields drop-down boxes and 

click Next .. 

7.  Click Finish. 

8.  View  the chart in Report view . 

9.  Sw itch to Design view  and double-click the chart to launch Microsoft Graph. 

10.  Click the Chart menu and select Chart Options from the menu. 

11.  Click the Data Labels tab and click the Percentage check box. 

12.  Click OK. 

13.  SAVE the chart. 

14.  View  the chart changes in Report view . 

15.  CLOSE the report. 

 

CLOSE the database . 
 

 

 

 

Project 13-4: Create a Chart for Lucerne Publishing 

As a sales manager for Lucerne Publishing, you are constantly analyzing and sharing sales data in 
meetings with the sales force as well as other departments in the corporation. Create a chart for 
your presentation at the next sales meeting. 

 
GET READY. LAUNCH Access if it is not already running. 

1. OPEN LucernePublishing from the data files for this lesson. 

2. SAVE the database as LucernePublishingXXX (where XXX is your initials). 

3. Create a chart using the Sales table. 

4. Use the Region, Gross Sales, and Net Sales fields as the fields for the chart. 

5. Create a Column chart. 

6. Drag and drop the Net Sales field button just below  the SumOfGross Sales box and 

click Next .. 

7. Select ,No Field. in the Report Fields and Chart Fields drop-down boxes and 

click Finish. 

8. CLOSE the report. 

 

LEAVE the database open for the next project. 
 

 

 

 

 

 

 

Project 13-5: Format the Lucerne Publishing Chart 

The chart you created worked fine for your presentation; however, you have just been asked to 
present the information at a meeting with your boss, so you decide to add formatting to make it 
look more professional. 

 
USE the database that is open from the previous exercise. 

1. Create a copy of the Sales report named Formatted Sales Chart. 

2. Using Microsoft Graph, change the chart to a new  Chart Type of your choice. 

3. Format the Chart Area using your choice of a Fill Effect. 

4. Format the data series by changing the color and format the walls of the chart 

(if applicable to the chart type chosen, if not applicable, this step may be skipped). 

Mastery  Assessment 
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5. Format the legend of the chart by changing its font and size. 

6. SAVE, print, and CLOSE the chart. 

 

CLOSE the database . 
 

 

 

 

Project 13-6: Fix the Wingtip Toys Yearly Sales Chart 

You asked an assistant to create a chart for the Yearly Sales Report, but 
it isn’t exactly what you wanted. Fix the chart. 

 
GET READY. LAUNCH Access if it is not already running. 

1. OPEN WingtipToys from the data files for this lesson. 

2. SAVE the database as WingtipToysXXX (where XXX is your 

initials). 

3. OPEN the Yearly Sales Report. 

4. LAUNCH Microsoft Graph and remove the data table at the bottom 

of the chart. 

5. Move the legend to the bottom of the report. 

6. Change the background color and pattern of the chart area to a 

solid light gray. 

7. SAVE and CLOSE the report. 

 

CLOSE Access. 

 


